iWave

Embedding Intelligence

User Manual for iMX27 based CE-ATA solution

R 1.0

User Manual for iMX27 based CE-ATA solution

Authors ZF

APPROVAL
Name Function

Distribution

Contact Info

Name

iWave Systems Tech. Pvt. Ltd.
7/B, 29" Main,

BTM Layout, 2" Stage,
Bangalore —560 076, India.

Organization

Telephone
+91-80-2668-3700
+91-80-2678-6245

iW-EMBQF-UM-01
R 1.0
10™ September, 2007

Date Signature

E-mail
embgf@iwavesystems.com

iWave Systems Technologies Pvt. Ltd.

(Confidential)

Page 1 of 27



L ]
l\k)ave User Manual for iMX27 based CE-ATA solution
R1.0

Embedding Intelligence

DOCUMENT IDENTIFICATION

Project Name IW-EMBQF

Document Name IW-EMBQF-UM-01 R1.0
Document Home

Revision No Rev 1.0

Status

Audience Actel

DOCUMENT REVISION HISTORY

Revision Date Change Description Author

1.0

PROPRIETARY NOTICE: This document contains proprietary material for the sole use of the
intended recipient(s). Do not read this document further if you are not the intended recipient.
Any review, use, distribution or disclosure by others is strictly prohibited. If you are not the
intended recipient (or authorized to receive for the recipient), you are hereby notified that any
disclosure, copy or distribution or use of any of the information contained within this document
is STRICTLY PROHIBITED. Thank you. “iWave Systems Tech. Pvt. Ltd.”

iWave Systems Technologies Pvt. Ltd. Page 2 of 27
(Confidential)



6]
lWave User Manual for iMX27 based CE-ATA solution

R 1.0

Embedding Intelligence

Table of Contents

1 INTRODUGCTION. ...ttt ettt e e e ettt e s st e e et e e e sebaeeeesabaeeeasbaeeesabaeseesabesesasbbesesaseesessabenesasseeseases 5
1.1 L= ] =TT 5
1.2 10T 0] =TT 5
1.3 UL = N 5

2 PROCEDURE TO SETUP HARDWARE FOR DEMO ...ttt 8
2.1 DETAILS REGARDING THE POWER CABLE INSERTION ....cciiiiuttiiiieeiiiiiiintieeeessiisbsreessesssssssssesssesssssssssesssesssnins 8
2.1.1  Power cable CONNECLION PrOCEAUIE......cc.ciuiiiieieeieiteie e te e te et e et esre st e besbeere e e eseesaesbestesaesreeneeneeseens 8

2.2 ACTEL JTAG PROGRAMMING . .....ciiiiitttitiieeiteiitbettsesssssisbbarteessssiabbasasasssssabbbaaeesesssabbbbseesesssabbbbssssesssassrrrns 9
2.3 SERIAL CABLE CONNECTION ....uuuttttiieeetsiittttteeesesssessesesesesssssssesssssesssassssssssasssessstsesssessssissssssssesessissssssseses 13
2.4 PROGRAMMING FLASH THROUGH SERIAL INTERFACE PROCEDURE .....cciiiiiiiiiiiiiieeesseiisieeseeessesssrenesesssens 14
R o 1Y o T (=Y LT LS (1 oSS 14

| - 1SS 15

3 GUI DIAGNOST I TEST S ..ttt ettt ettt e e et e e e ettt e e st e ee s s et b e e e sasteesssabeeessatbesesassesessabenesssrbeeesanes 24
3.1 LAUNCH WINDOWS CE ...ttt ettt ettt sttt s bt e s s bt e e s s eatt e s s s aba e e e s sbb e e s s aatae s e sabanesssrbeeeaas 26

4 WINDOWS CE OPERATING SYSTEM ...ttt et ettae e stae e et e e s eaaan e sareeas 27
41 BROWSING THE DEVICE CONTENTS ...cttttttieeetiiittetieesessiisststesesesssassssesssesssassssesssesssasssssesssesssosssssesssessssins 27

iWave Systems Technologies Pvt. Ltd. Page 3 of 27

(Confidential)



L ]
l\X?ave User Manual for iMX27 based CE-ATA solution
R1.0

Embedding Intelligence

List of Figures

Figure 1: iMX27 based CE-ATA BOArd SEIUD.......civeieiirire it eeeeee st se e ste e e te e srestesseesaeseeseseesnesreaneesaessenses 6

Figure 2: Accessories with iMX27 based CE-ATA BOArd SEIUP........coevvieieeieeeeieseesesie e seseeseeseesie e snessessnesaeseenss 7

1o U G Rl o1V g @) T o 1o USRS 8

Figure 4: FPGA programming CONNECLION .........uciviiieiieieiiiesteeeeieete st e ste e ste e s e eseesaesbesbesbestaeseessessebestesaestesneenaesennes 9

Figure 5: FPGA programming CONNECLIONT ........coueiiiiiiiiiiteiti ettt st s b bbbt e st sb et sbe st e e e eneennen 10

Figure 6: Serial cable connection during the programming of flash...........cccocoviii 13
iWave Systems Technologies Pvt. Ltd. Page 4 of 27

(Confidential)



6]
lWave User Manual for iMX27 based CE-ATA solution

Embedding Intelligence R 1.0

1 Introduction

1.1 Purpose

The purpose of this document is to explain the procedure to power-on and test the iMX27 based CE-ATA solution
board.

1.2 Scope

This document describes the Hardware connection procedure to power-on and perform the GUI diagnostic tests to
verify the working of CE-ATA and WinCE using the Touchscreen.

1.3 Setup Details

Each setup consists of One board with the LCD and CE-ATA hard disk connected. The entire set up is as shown in
the Figure 1.

1. Processor Board (iW-EMBQF-AP-01-XX).

iWave Systems Technologies Pvt. Ltd. Page 5 of 27
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Figure 1: iMX27 based CE-ATA Board Setup
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The accessories along with the board setup is shown in the Figure 2

Serial to USB connector and CD

CE-ATA card

Figure 2: Accessories with iMX27 based CE-ATA Board Setup

The Accessories is as follows

Power Supply

CE-ATA card

Serial Cable for the Flash programming

Customized cable for programming Actel FPGA. This cable to be connected between JTA programmer and
Board JTAG connector

Serial to USB convertor, with the CD (if DB-9 port not available in the PC/laptop)

YV VVVY

iWave Systems Technologies Pvt. Ltd. Page 7 of 27
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2 Procedure to setup Hardware for Demo

2.1 Details regarding the power cable insertion

2.1.1  Power cable Connection procedure
Insert the power cable into the power connector of the Mother-board as shown in the Figure 3

Figure 3: Power Connection

iWave Systems Technologies Pvt. Ltd. Page 8 of 27
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2.2 Actel JTAG programming

Figure 4: FPGA programming connection
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Figure 5: FPGA programming connectionl
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Select Programmer settings from Tools menu

Wilashero - [t] E =18 x]
Fle Ede View | Tods Mrogrammers Corfigration Customie Help
e s ol
|0 & o [ .
Seoiazaticn = —
«— D | cotgunvors (|
28 Corract Paralel Port Catie. .. | = = FAOBAH %I
Mon prov— L =3 View Progiamimens %[
T~
I+ Programmer Progasmer Porl Progsmaer Piogrammer |
Hame | Ty | Shaluz F il
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El
:f FPehesh/Petcan for Prosrammess I
x| Software Version: 0.0.0.40
< PIE file 'CiiDocuments nnd Seccings)khadeer)Deakeop) ciceacnhosc. pdn' has been londed auceesatolly.
DESIGN : ceatahost:; CHECESUN @ 0J2¢: FRU VERSION i 1.0
Driver : 2.0.4 build 2
proge 04433' 3 FlashProd
opened ‘Ol Documents and Settings)khadesr) Desktopitit.pro’
||l 5D\ an fEmoes y wames Joiie 7
[ ——— < = b SINGE
Whsrart ||| ) & 52 2 * | S - Otk Frprmss | Dot - Merosit [ {Psshere - 101 s ek | [BUE s

Set TCK frequency to 1MHz under FlashPro3 tab
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Sorevare Version: 0.0.0.40
FLE Zile ‘C:h and 3
DESIGH : ceatahost: CHECESUN : 0326: PDB_VERSION : 1.0
Driver i 2.0.4 build 2

'04433" : F

pdb’ has been lomded successfully.

Then Program the FPGA.
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2.3 Serial Cable connection

(DB-9 connector to the PC

Figure 6: Serial cable connection during the programming of flash

» DB-9 connector needs to be connected to the PC/laptop. If serial connection not available use the Serial to

USB convertor (Installation CD also available with the accessories).
» The other end of the serial cable needs to be connected to the Board. Please see the connector position as

shown above in the Figure 6

iWave Systems Technologies Pvt. Ltd. Page 13 of 27
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2.4 Programming Flash through Serial interface procedure

2.4.1  Hyperterminal Setup

1.Go to Start >Programs-> Accessories>Communication-> Hyperterminal on the host PC.
2.Select COM1 or COM2 port depending on to which port you have connected the serial cable.
3.Click Configure button.Now configure as below.

Bits per Second (Baud Rate) : 115200
Data bits : 8
Parity : None
Stop Bits 1

Flow Control : None

4. Go to File-> Properties>Settings=>ASCI I Setup. There select Echo Typed Characters locally.

iWave Systems Technologies Pvt. Ltd. Page 14 of 27
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24.2

1.
2.

Steps

Switch ON the Board.
Now Hyperterminal shows as below

ilave Systems Tech. Put. Ltd.
Rainbow G3 Monitor

Version 0.1

i.MK27 RAINBOW G3

BOARD INFO
Area Start address End address Size
SDRAM 0xa000_0000  0xadff_ffff 64 MB

Data section Bxa3e0_0000 Oxa3ef _ffff 1 MB
UsrStack 0xa3f0_0000 0xa3fO_ffff 64 KB
TROStack Oxa3fl1_0000 0xa3fl_ffff 64 KB
FIQStack Oxadf2_ 0000  Oxal3f2_ffff 64 KB
UndefStack 0xadfd_0000 0xadfd_ffff 64 KB

AbortStack  Owa3f4_0000 Ouxadf4_ffff 64 KB
SYCStack 0xa3fo_0000  Oxadfo_ffff 64 KB
SYSStack 0xalf6_0000  Oxadfo_ffff G4 KB

Flash 0xc000_0000  Oxclff_ffff 32 MB
Bootloader BxcO06_0000 Oxffff_fffe 10823 MB
Kernel Oxffff_fiff  Ouffff_fffe 0 MB
Initrd Oxffff_ffff Oxffff_fffe 0 MB

Filesystems Oxffff_ffff Ouclff_ffff 3104 MB

Going to boot linux from flash. Press any key with in 10 sec for diagnostics

FPGA supported

Enabling I2C Controller

The PCCRO is: Bxb10c&80fSwitching on LCD
Switched on LCD
Drawing Screen 1
draw_screen max_control = 1Drawn Screen

loop starts

loop ends now in current menuGoing to next Screen
Drawing Screen 2

draw_screen max_control = 2Drawn Screen

iWave Systems Technologies Pvt. Ltd.
(Confidential)
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3. Press any Key to continue in Diagnostic Menu.
4. Now Press D to download the file

SDRAH 0xalB0_BOO0  Ona3ff_ffff 64 MB
Data section Bxa3eB 0000  Oxadef ffff 1 HB
UsrStack 0xa3f0_BOB0  Oxa3TO_Tfff 64 KB
IRQStack 0xa3f1_0000 Oua3fl_ffff 64 KB
FIQStack Oxa3f2_00O0 Ona3f2_ffff 64 KB
UndefStack  0xa3f3 0000 0xa3f3_ffff 64 KB
AbortStack Bxa3fi_0000 Oxa3fi_fTff 64 KB
SYCStack 0xa3f5_0000 Oua3fS_ffff 64 KB
S¥YSStack Oxa3f6_DOO0  Ona3f6_ffff 64 KB
Flash 0xcOB0_0000  Oxclff _ffff 32 MB
Bootloader B=cP00_PRnn Buffff_fffe 1023 MB
Kernel OxfTff_ffff Ouffff_fffe 0 HB
Initrd OxfTff_ffff Ouffff_fffe 0@ HB
Filesystens Oxffff_ffff Oxclff_ffff 3104 HB

Going to boot linux from flash. Press any key with in 10 sec for diagnostics

FPGA supported

Enabling I2C Controller

The PCCRO 1s: OxblBc480fSwitching on LCD
Switched on LCD

Drawing Screen 1

draw_screen max_control = 1Drawn Screen

loop starts

loop ends now in current menuGoing to next Screen
Drawing Screen 2

draw_screen max_control = 2Drawn Screen

inside powr off

RAM test

Read-YUrite Memory

CSPT Test

Download File

Environment variable

Flash Program

Gui Menu

LCD Test

SD/HMC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3> d

Enter the SDRAM download address : _

Mo mMMmMoamDI

Connected 2:22:14 [adtodetect  [1152008-N-1  [SCROLL [CAPS [wum  [Capture  [Print echa

iWave Systems Technologies Pvt. Ltd.
(Confidential)
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5.Give SDRAM download address as A3000000 and then Press Y.

Data section Bxa3e0_0000 Oxadef ffff 1 MB
UsrStack 0xa3f0_0000 Oxa3f0_ffff 64 KB
IRQStack Oxadf1_0000 Oxa3fl_ffff 64 KB
FIQStack Oxadf2_0000 Oxa3f2_fiff 64 KB
UndefStack Bxa3f3_0000 0xa3f3 ffff 64 KB
AbortStack Bxa3f4i_0000 Oxa3fi_ffff 64 KB
SVCStack 0xa3f5_0000 Oxa3fS_ffff 64 KB
SYSStack 0xa3f6_0000 Oxa3f6_ffff 64 KB

Flash 0xch00_0000 Oxclff_ffff 32 MB
Bootloader Oxc000_0000 Oxffff_fffe 1623 HB
Kernel Oxffff_ffff Oxffff_fffe 0 MB
Initrd Oxffff_ffff Oxffff_fffe 0 MB

Filesystems Oxffff_ffff Ouclff_ffff 3104 MB

Going to boot linux from flash. Press any key with in 18 sec for diagnostics

FPGA supported

Enabling I2C Controller

The PCCRO is: Bxb10c480fSwitching on LCD
Switched on LCD

Drawing Screen 1

draw_screen max_control = 1Drawn Screen

loop starts

loop ends now in current menuGoing to next Screen
Drawing Screen 2

draw_screen max_control = 2Drawn Screen

inside powr off

RAH test

Read-Write Memory

CSPI Test

Download File

Environment variable

Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card

Run From Address

Touch Panel Test

Boot Linux from Flash

Launch Linux form SD Card

Please select an option .......

RainbowG3> d

Enter the SDRAM download address : a3000000
Download File on to a3000000. Proceed <y/n>?

MNxHEZIromMMmMeaamID

lonnecked 2:23:22 Auto detect 115200 &-N-1 UM

iWave Systems Technologies Pvt. Ltd.
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6. Goto Transfer - Sent Text File in the hyper-terminal

File Edit Wiew Call Transfer Help

Send Text File il 4|

Loak. in: IaHyperTermlnal LI - [ '

|0 sec for diagnostics

File namme: Ic:\imx_d\ag Lug j Open I
2 Files of type: [Text file (- T<T) =] Cancel |

T T oo TS T AR CTCF oo oW I TCITITg O CoD
Switched on LCD

Drawing Screen 1

draw_screen max_control = 1Drawn Screen

loop starts . .
loop ends now in current menuGoing to next Screen

Drawing Screen 2
draw_screen max_control = 2Drawn Screen

inside powr off

M test
Read-Yrite Memory
CSPT Test
Download File
Environment variable
Flash Program
Gui Henu
LCD Test

SD/MHC Test

Load WinCE from SD card

Run From Address

Touch Panel Test

Boot Linux from Flash

Launch Linux form SD Card
Please select an option .......
RainbowG3>

Enter the SDRAM download address :
Download File on to a3000000. Proceed <w/n>?
Send the UUE encoded file

e B - o gl | g g L L g e o ]

Connected 0:00:26 muto detect  [1152008-W-1  (SCROLL [CAPS oM [Capture (Print echo
iWave Systems Technologies Pvt. Ltd. Page 18 of 27
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7.Give the location of the file imx_diag.uue and then give open.
8.After downloading press any key to continue.

File Edit View Call Transfer Help

D& |m 8|00 &

Drawing Screen 1
draw_screen max_control = 1Drawn Screen

loop starts

loop ends now in current menuGoing to next Screen
Drawing Screen 2

draw_screen max_control = 2Drawn Screen

inside powr off

M test
Read-Write Memory
CSPI Test
Download File
Environment variable
Flash Program
Gui Menu
LCD Test

SD/MHC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......

MO O TIMEOCmI

RainbowG3>

Enter the SDRAM download address :

Download File on to a3000000. Proceed <y/n>?
Send the UUE encoded file

............... Downloaded l4ecB® bytes on to a3000000

Press any kev to continue

M test
Read-YWrite Memory
CSPI Test
Download File
Environment variable
Flash Program
Gui Menu
LCD Test
SD/MHC Test
Load WinCE from SD card
Run From Address
Touch Panel Test
Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3> _

NI omMmMoaomoDI

Connected 0:02:53 lauto detect  [1152008-M-1  [SCROLL  [CAPs oM [Capture  [Print echo

iWave Systems Technologies Pvt. Ltd.
(Confidential)
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9.Press F to enter in to Flash programming menu.
D Download File

Environment variable

Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card

Run From Address

Touch Panel Test

Boot Linux from Flash

Launch Linux form $SD Card

Please select an option .......

RainbowG3>

Enter the SDRAM download address :

Download File on to a3000000. Proceed <v/n>?

Send the UUE encoded file

............... Downloaded 1l4ecB bytes on to a3000000

MO =Xr Gm

Press any key to continue
H test

Read-Hrite Memory

CSPI Test

Download File

Environment variable
Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3> f

MO omm DoOCmDD

% Flash Programming utility %

Program the diagnostic code
Program the zImage

Program the initrd

Program the FFS area

Exit

Mmoo mDD

Select an option :

Connected 0:03:43 laubo detect (115200 8M-1  [SCROLL [CAPS [MOM [Capburs (Prinkecho
iWave Systems Technologies Pvt. Ltd. Page 20 of 27
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10.Press A to program the diagnostic code.

File Edit Wiew Call Transfer Help
D& 3|08 | &

Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card

Run From Address

Touch Panel Test

Boot Linux from Flash

Launch Linux form SD Card
Please select an option .......
RainbowG3>

Enter the SDRAM download address :
Download File on to a3000000. Proceed <v/n>?7
Send the UUE encoded file

--------------- Downloaded liecB bytes on to a3000000

PN EZZr @

Press any key to continue

M test
Read-Write Memory
CSPT Test
Download File
Environment variable
Flash Program
Gui Menu
LCD Test

SD/MMC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3> f

MX—DZZIr | TMIMEeaWD

= Flash Programming utility =

Program the diagnostic code
Program the zImage

Program the initrd

Program the FFS area

Exit

moomDI

Select an option : a

Have vou downloaded the file in SDRAM location 0xA30000080 (v/n)

Cornected 0:0¢:26 [adtodetect  [1152008-M-1  [SCROLL  [CAPS  [wuM [Capfure  [Print echo
iWave Systems Technologies Pvt. Ltd. Page 21 of 27

(Confidential)



®
l \X/ ave User Manual for iMX27 based CE-ATA solution
R1.0

Embedding Intelligence

11.Press Y and then give 00020000 as size.

File Edit wiew Call Tramsfer Help
D@ 5|05 |

Read-Write Memory

CSPI Test

Download File

Environment variable
Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3>

Select a valid option. Press any key to continue
RAH test

Read-Urite Memory

CSPT Test

Download File

Environment variable
Flash Program

Gui Menu

LCD Test

SD/MMC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbouwG3> f

NX—O=ZZroOmmocm

MNX—D=ZX | T ommoecomD

= Flash Programming utility =

Program the diagnostic code
Program the zImage

Program the initrd

Program the FFS area

Exit

mocomD

Select an option : a

Have vou downloaded the file in SDRAM location OxA3000600 (v/n) : v
Enter the size of the data : 00020000
Proceed <y/n>?

Connecked 0:08:39 ‘Auto detect 115200 8-N-1 SCROLL |C»QPS MM ‘Capture Print echo
iWave Systems Technologies Pvt. Ltd. Page 22 of 27
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12.Now press Y to program the flash.
13.After Flash programming is over,Hyperterminal shows as below

Fil= Edit W%iew Call Transfer Help
D@ 3 |0. |

Gui Menu

LCD Test

SD/MHC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash
Launch Linux form SD Card
Please select an option .......
RainbowG3>

Select a valid option. Press any key to continue
RAM test

Read-Hrite Memory

CSPI Test

Download File

Environment variable
Flash Program

Gui Menu

LCD Test

SD/MHC Test

Load WinCE from SD card
Run From Address

Touch Panel Test

Boot Linux from Flash

Z Launch Linux form SD Card
Please select an option .......
RainbowG3> f

MX—D=ZZC SO

XD oTIMoOOmD

= Flash Programming utility =

Program the diagnostic code
Program the zImage

Program the initrd

Program the FFS area

Exit

moomD

Select an option : a

Have you downloaded the file in SDRAM location B0xA3000000 (v/n) : v
Enter the size of the data : 00020000
Proceed <yv/n>? v

Erasing Sector......... i

Programming Sectors..... HHHH R
Verifying Programmed Data: ................ ... .............
verified

Flash Programming Done

Connected 0:11:14 |F\uto detect |1 15200 8-M-1 SCROLL |CAPS |NUM |Capture Print echo

14.Now Switch off the board and then switch ON the board.

iWave Systems Technologies Pvt. Ltd. Page 23 of 27
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3 GUI Diagnostic Tests

The GUI menu will be displayed as below when the set up is powered ON. The display menu on
the LCD is as shown below.

Wave Systems Tech.Put. Ltd

Main Menu

CE-ATA Test
Launch WinCE from Flash

Now touch CE-ATA Test using stylus to enter in to the CE-ATA test.

iWave Systems Tech.Pvt. Ltd
CE-ATA Test

iWave Systems Technologies Pvt. Ltd. Page 24 of 27
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If CE-ATA is Present GUI shows Model No,Serial No,Card Size as below.Press Exit to go to the Main Menu.

iWave Systems Tech. Pwt. Ltd

CE-ATA Test

Model No : HMS361008 M5 CAD

Serial No : MNCODOMZ0AUZTG

Card Size [in MB] : 7168

If CE-ATA is not Present GUI as below.Press Exit to go to the Main Menu.

iWave Systems Tech.Pwt. Ltd

CE-ATA Test

iWave Systems Technologies Pvt. Ltd. Page 25 of 27
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3.1 Launch WINDOWS CE

In the Main Menu touch Launch WInCE fron Flash to Launch WinCE.

Wave Systems Tech.Put. Ltd

Main Menu

Launch WinCE from Flash

CE-ATA Test

iWave Systems Technologies Pvt. Ltd. Page 26 of 27
(Confidential)



6]
lWave User Manual for iMX27 based CE-ATA solution

R 1.0

Embedding Intelligence

4 Windows CE Operating System

4.1 Browsing the device contents

Various folders and files present in the device can be accessed from the My Device icon on the
WinCE Desktop.

N =

ook w

Double click on the My Device icon on the desktop.

The Explorer window will pop up. The contents of the device can be browsed just like
using the Explorer in a Windows PC.

Double Click the Windows folder.

Now double click the Beta Player to play movies.

Then Media player window will popup.

Go to File> Open—>Windows->Matix to play movie.

iWave Systems Technologies Pvt. Ltd. Page 27 of 27
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